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Support

Please visit the HP OpenView web site at:

http://www.managementsoftware.hp.com/ 

This site provides contact information and details about the products, services, and support that HP 
OpenView offers. To reach the Support site, click Support. The Support site provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valuable support customer, 
you can benefit by using the support site to:

• Search for documents of interest

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Join online discussions with other software customers

• Research and register for software training

Most of the support areas require you to register as an HP Passport user and log in. You may also require a 
support contract.

To find more information about access levels, go to the following URL:

http://support.openview.hp.com/access_level.jsp 

To register for an HP Passport ID, go to:

https://passport.hp.com/hpp2/newuser.do
3



4



contents
Chapter 1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Introduction to Device Resources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Folders and Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Ways to Customize Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Sources for Additional Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Chapter 2 Package Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Guidelines for a Smooth Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Installing Device Resources 3.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Post Installation Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Options for Viewing Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Seeing Performance Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Removing Device Resources 3.0. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Chapter 3 Distributed Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Package Installation for a Distributed System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Configuring the Central Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Configuring Satellite Servers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
System Clocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Chapter 4 Exception Thresholds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Default Thresholds for Exceptions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Using the Change Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Chapter 5 Top 10 Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Chapter 6 Summary Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Chapter 7 Forecast Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Chapter 8 Service Level Management  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Chapter 9 Near Real Time Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Chapter 10 Editing Tables and Graphs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

View Options for Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
View Options for Graphs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
5



Contents
Glossary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
6



Chapter 1
Overview

This chapter addresses the following topics:

• Introduction to the Device Resources Report Pack

• Package version history

• Data collection 

• Folders and reports

• Integration with Network Node Manager (NNM)

• Ways to customize reports

• Sources for additional information

Introduction to Device Resources

The Device Resources Report Pack monitors CPU, memory, and buffer resources in switches 
and routers. These resources function independently. If a buffer is overutilized, the CPU that 
moves data in and out of the buffer could be underutilized. Similarly, if the CPU is 
overutilized, buffer and memory could be underutilized. Device Resources does not monitor 
server resources. Use the System Resources Report Pack to monitor server resources.

You have synergies to exploit by running Device Resources and Interface Reporting at the 
same time. If Interface Reporting is showing high discards or high errors, Device Resources 
will tell you whether or not overutilization of a resource could be contributing to the problem. 
If Device Resources indicates that network response time is spiking, Interface Reporting will 
tell you whether interface utilization levels are contributing to the problem.

The following table provides details about recent enhancements to Device Resources.

Version RNS Release and Date Features/Enhancements

1.0 RNS 2.0 - January 2003 15 reports; Sybase support

1.0 RNS 3.0 - May 2003 No changes
7



Folders and Reports
Folders and Reports

The Device Resources Report Pack contains 20 reports. The report folders are:

• Customer

• Device

• Location

• Backplane

The following table indicates the contents of each folder. 

2.0 RNS 4.0 - October 2003 OVPI Object Manager support
change form:
• Update Thresholds
backplane utilization reports:
• Historical Summary
• QuickView
• Snapshot
• Near Real Time QuickView
• Near Real Time Snapshot

3.0 RNS 5.0 - April 2004 Oracle support
new datapipe:
• Dev Res Cabletron Datapipe

3.0 RNS 6.0 - August 2004 2.0-to-3.0 upgrade package 

3.0 RNS 7.0 - November 2004 new datapipe:
• Dev Res Juniper Router Datapipe 1.0

Version RNS Release and Date Features/Enhancements

Report Type Customer Device Location Backplane

Exceptions Summary X

Card Historical Summary X

Historical Summary X X

Historical Summary Snapshot X

QuickView X

Snapshot X

NRT QuickView X X

NRT Snapshot X X

Forecast X X X
8



Chapter 1
Collecting Data and Properties

The following vendor-specific datapipes are available to collect data for Device Resources:

1 Dev Res 3COM Router Datapipe

2 Dev Res Alcatel Xylan Switch Datapipe

3 Dev Res Cabletron Datapipe

4 Dev Res Cisco Switch Datapipe

5 Dev Res Cisco Router Datapipe

6 Dev Res Enterasys Router Datapipe

7 Dev Res Enterasys Switch Datapipe

8 Dev Res Extreme Devices Datapipe

9 Dev Res Foundry Datapipe

10 Dev Res HP ProCurve Datapipe

11 Dev Res Juniper Router Datapipe

12 Dev Res Nortel Bay Datapipe

In addition to performance data, reports contain the following kinds of property information:

• IP addresses

• Host names

• Customers

• Locations

Property information is stored in tables maintained by Common Property Tables. If you are 
about to install Common Property Tables for the first time, you will not see customers or 
locations in reports until you import this information. You can import customers and locations 
in batch mode, by creating a file and importing the contents, or you can import locations and 
customers using the “create new” forms bundled with Common Property Tables. For details, 
refer to the Common Property Tables 3.5 User Guide. 

Integration with Network Node Manager

If you use NNM as well as OVPI, you have the option of improving your problem diagnostic 
abilities by integrating OVPI with NNM. Integration is accomplished by installing the NNM/
Performance Insight Integration Module 2.0. This module includes packages for NNM and 
packages for OVPI. See the NNM/Performance Insight Integration Module 2.0 User Guide for 
details.

Service Level Management X

Summary X X

Top Ten X X X

Report Type Customer Device Location Backplane
9



Ways to Customize Reports
If NNM and OVPI are integrated, you can configure OVPI to send thresholds traps to NNM by 
installing the optional thresholds sub-package that comes with Device Resources. The 
optional thresholds sub-package contains pre-set thresholds. Once the thresholds sub-
package is installed, OVPI will send threshold traps to NNM when thresholds are exceeded 
and when threshold conditions return to normal. Traps delivered to NNM become alarms in 
the NNM alarm browser. 

The optional thresholds sub-package requires the Threshold and Event Generation Module, 
also known as the Thresholds Module. If you select the thresholds sub-package for 
installation, Package Manager will select and install the Thresholds Module for you. For 
details about configuration options for the Thresholds Module, refer to the Thresholds Module 
5.0 User Guide.

Ways to Customize Reports 

You can customize reports by applying group filters, by applying constraints, by editing tables 
and graphs, and by importing property information (node names, host names, customers, and 
locations). Service providers, or any organization that wants to share reports with customers, 
use group filters to produce customer-specific reports. Anyone viewing a report can apply a 
constraint, edit tables, and edit graphs. 

Group Filters

If you want to share reports with your customers, you must configure OVPI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to import customer names and device locations

• Create a group account for all the users affiliated with each customer

• Create a group filter for each group account

For more information about creating filters for group accounts, refer to the Performance 
Insight 5.0 Administration Guide. 

Applying Constraints

Editing a parameter applies a constraint to the report. The constraint eliminates data you are 
not interested in seeing. For example, if you edit the Customer Name parameter, data for 
every customer except the customer you typed in the Customer Name field drops from the 
report. Device Resources supports the following parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Make

• Model
10



Chapter 1
If you are using a web browser to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Sources for Additional Information

This user guide provides samples of some of the reports in Device Resources. The demo 
package that comes with Device Resources is complete, containing a sample of every report in 
the package. If you have access to the demo package and you want to know what fully-
populated reports look like, install the demo package. Like real reports, demo reports are 
interactive. Unlike real reports, demo reports are static.

The following documents are related to this manual: 

• Executive Summaries Report Pack 1.0 User Guide

• Common Property Tables 3.5 User Guide

• NNM / Performance Insight Integration Module 2.0 User Guide

• Thresholds Module 5.0 User Guide 

• RNS 7.0 Release Notes, November 2004

The following release statements are related to this manual: 

• Device Resources Report Pack 3.0 Release Statement

• Dev Res 3COM Router Datapipe Release Statement

• Dev Res Alcatel Xylan Switch Datapipe Release Statement

• Dev Res Cabletron Datapipe Release Statement

• Dev Res Cisco Switch Datapipe Release Statement 

• Dev Res Cisco Router Datapipe Release Statement 

• Dev Res Extreme Devices Datapipe Release Statement

• Dev Res Foundry Datapipe Release Statement

• Dev Res HP ProCurve Datapipe Release Statement 

• Dev Res Juniper Datapipe Router Release Statement

• Dev Res Nortel Bay Datapipe Release Statement 

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on 
OVPI are posted to the following website:

http://www.managementsoftware.hp.com

Select Support > Product Manuals to open the Product Manuals Search page. User guides for the 
core product, Performance Insight, are listed under Performance Insight. User guides for report 
packs, datapipes, preprocessors, and value-add components for NNM (SPIs and correlators) 
are listed under Reporting and Network Solutions. 
11



Sources for Additional Information
The manuals listed under Reporting and Network Solutions indicate the date of publication. 
If a user guide is revised and reposted, the date will change even if the software version 
number does not change. Since we post revised user guides on a regular basis, you should 
search this site for updates before using an older manual that may be outdated.
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Chapter 2
Package Installation

This chapter covers the following topics:

• Guidelines for a smooth install

• Installing Device Resources 3.0

• Removing Device Resources 3.0 

Guidelines for a Smooth Install

Each reporting solution that runs on OVPI consists of a report pack and one datapipe, or 
sometimes a report pack and multiple datapipes. When you install the datapipe, you configure 
OVPI to collect a specific type of performance data at a specific polling interval. When you 
install the report pack, you configure OVPI to summarize and aggregate performance data in 
a specific way.

The RNS 7.0 CD includes components for NNM as well as report packs and datapipes for 
OVPI. When you insert the CD, launch the package extraction interface, and select OVPI 
report packs for extraction, the install script copies every OVPI package from the RNS CD to 
the Packages directory on your system. After the extraction process finishes, the install script 
prompts you to start Package Manager. Before installing Device Resources 3.0 by following 
the on-screen directions, review the following guidelines. 

Software Prerequisites

Version 3.0 of Device Resources has the following prerequisites:

• OVPI 5.0

• All service packs available for OVPI 5.0

• Common Property Tables 3.0 or higher 

If you are not currently running any version of Common Property Tables, let Package 
Manager install version 3.5 for you. If you are running an earlier version of Common Property 
Tables, upgrade to version 3.0 or 3.5. Installing upgrade packages for Common Property 
Tables is easy. However, if you need assistance or if you want to know more about how this 
package operates, refer to the Common Property Tables 3.5 User Guide.
13



Guidelines for a Smooth Install
Datapipes

The datapipes that collect data for this report pack are not prerequisites. You may install the 
datapipes when you install the report pack or you may install the datapipes after you install 
the report pack. The following datapipes are available for installation:

1 Dev Res 3COM Datapipe

2 Dev Res Alcatel Datapipe

3 Dev Res Cabletron Datapipe

4 Dev Res Cisco Switch Datapipe

5 Dev Res Cisco Router Datapipe

6 Dev Res Enterasys Router Datapipe

7 Dev Res Enterasys Switch Datapipe

8 Dev Res Extreme Devices Datapipe

9 Dev Res Foundry Datapipe

10 Dev Res Juniper Router Datapipe

11 Dev Res Nortel Bay Datapipe

12 Dev Res HP ProCurve Datapipe

Thresholding and Alarms

If your OVPI and NNM servers are integrated, you will probably want to install the 
thresholds sub-package, Device_Resource_Thresholds, on your OVPI server. This optional 
package contains customized thresholds. If you install it, the threshold traps generated by 
OVPI will display as alarms in the NNM alarm browser. 

If you install the thresholds sub-package, Package Manager will install the Thresholds 
Module for you, automatically. The Thresholds Module controls the actions that OVPI takes in 
response to a threshold breach. For details about configuring optional actions, refer to the 
Thresholds Module 5.0 User Guide. 

Distributed Environments

If you intend to run Device Resources in a distributed environment, the installation procedure 
is more complex. Here is an overview of the steps:

1 Make sure that every server is running the same version of OVPI.

2 Make sure that every server is running all available service packs for OVPI. 

3 Disable trendcopy on the central server.

4 Install the following packages on the central server:

• Device Resources; deploy reports 

• Device_Resource_Thresholds

• Common Property Tables 3.0 or higher; deploy reports (forms in this context)

5 Install the following packages on each satellite server:
14
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• Device Resources; deploy reports

• Common Property Tables 3.0 or higher

• Device_Resource_Thresholds

• At least one datapipe

6 Re-enable trendcopy on the central server.

After installing Device Resources on OVPI servers in a distributed environment, you need to 
configure the environment by setting up connections with satellite server databases, 
configuring the central server with trendcopy pull commands, and switching off aggregations 
at each satellite server. These tasks are covered in Chapter 3, Distributed Systems.

Upgrading from Device Resources 2.0

If you are currently running Device Resources 2.0, you may upgrade to version 3.0 by 
following these steps:

1 Install the upgrade package for Common Property Tables; deploy reports (forms).

2 Remove the datapipes you installed when you installed Device Resources 2.0.

3 Install the upgrade package for Device Resources 3.0; deploy reports.

4 Install new datapipes for Device Resources 3.0. 

Polling Policies for Remote Pollers

When you uninstall an existing datapipe, the following information will be lost:

• Polling policies for remote pollers

• Multi-poller policies 

• Customized polling groups 

You can export existing polling policy configurations and customized polling groups by using 
the collection_manager and group_manager commands.

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 
15



Installing Device Resources 3.0
UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Dropping Customized Data Table Views

If you created custom data table views using existing property table views, drop the custom 
data table views now, before upgrading the report pack. Dropping custom table views will not 
lose data. 

Upgrading to Version 3.0 in a Distributed Environment

If you installed Device Resources 2.0 on multiple servers running OVPI 4.6, you configured 
the servers in your system by using DS EDIT to set up connections with satellite server 
databases. You also configured trendcopy pull commands and switched off hourly 
aggregations at each satellite server. If you upgraded from OVPI 4.6 to OVPI 5.0, the 
following changes must be repeated as soon as you upgrade the report pack:

• Set up connections with satellite databases (this time using the Add Database Wizard)

• Configure trendcopy pull commands

For details, see Chapter 3, Distributed Systems.

Installing Device Resources 3.0

Follow these steps to install Device Resources 3.0:

1 Log in to the system. On UNIX® systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop
16
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3 Insert the RNS CD. 

Windows: The Main Menu automatically displays. 

UNIX: 

a Mount the CD (if the CD does not mount automatically).

b Navigate to the top level directory on the CD.

c Run ./setup

4 Type 1 in the choice field and press Enter. 

After the install script has copied every package to the Packages directory on your system, 
follow the prompts to launch Performance Insight and start Package Manager. The 
Package Manager welcome window opens.

5 Click Next. The Package Location window opens.

6 Click Install. 

7 Approve the default destination directory or browse to a different directory, if necessary, 
and click Next. The Report Deployment window opens. Type your username and password 
for the OVPI Application Server

8 Click Next. The Package Selection window opens. 

9 Click the check box for the following packages:

Device Resource 3.0

Device Resource Thresholds [optional]

Device Resources Demo Package [optional]

10 Click the check box for at least one datapipe.

11 Click Next. The Type Discovery window opens. 

12 To run Type Discovery immediately after package installation, accept the default and 
click Next. The Selection Summary window opens.

13 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

14 Click Done. 

15 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
17



Post Installation Steps
Post Installation Steps

Reconfigure any polling policies and customized group definitions that need to be restored. Do 
not re-import the configurations you exported. Because the old datapipe may be incompatible 
with the new datapipe you just installed, re-importing the configurations you exported could 
lead to data corruption. 

If you dropped any customized data table views that were based on existing report pack 
property table views, you can recreate those custom views now. 

Options for Viewing Reports

When you installed Device Resources, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any associated forms) were deployed to the OVPI 
Application Server. Once reports reside on the OVPI Application Server, you have two ways to 
view them:

• OVPI clients

• Web browser

If the client components are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the client components are not installed on 
your system, using a web browser is the only way you can view reports.

For more information about the client components, refer to the Performance Insight 
Installation Guide. For more information about the Management Console, including how to 
use the Object/Property Management view to launch reports specific to a selected object, refer 
to the Performance Insight Administration Guide.

Seeing Performance Data 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, reliable forecast data will not be available for about six weeks, when the 
rolling baseline is complete.

Removing Device Resources 3.0

Removing Device Resources automatically removes any datapipe that depends on Device 
Resources. Follow these steps to uninstall the Device Resources package.

1 Log in to the system. On UNIX systems, log in as root.

This information applies to upgrades only.
18
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2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager and follow the on-screen directions for uninstalling packages; 
when prompted, select Device Resources for removal. When the uninstall process finishes, 
a package removal complete message appears.

4 Click Done.

5 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
19
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Chapter 3
Distributed Systems

This chapter covers the following topics:

• Proper package installation for a distributed system

• Configuring the central sever

• Configuring satellite servers

• System clocks

Package Installation for a Distributed System

If you intend to run Device Resources as a distributed system, you must configure each server 
in the system. Before doing that, verify that package installation was done correctly. Here are 
the guidelines for package installation in a distributed environment:

• Device Resources 3.0 is installed on every server.

• At least one datapipe is installed on each satellite server.

• If you want to enable thresholding for aggregated data only, install the thresholds sub-
package and the Thresholds Module on the central server.

• If you want to enable thresholding for hourly data or rate data, install the thresholds sub-
package and the Thresholds Module on satellite servers only. 

Configuring the Central Server

Perform these tasks to configure the central server:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands for hourly data

• Task 3: Configure trendcopy pull commands for rate data (optional)

Task 1: Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.
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Configuring the Central Server
3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 When you finish adding databases, click Finish. 

Task 2: Configure trendcopy pull commands for hourly data

1 Open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

2 Uncomment the copy commands in the hourly_copy block.

3 Modify the copy commands in the hourly_copy block as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name.

• Replace THIS_MACHINE_DATABASE with the central server name.

4 If you have multiple satellite servers, create and configure hourly copy commands for each 
server. 

Task 3: Configure trendcopy pull commands for rate data (optional)

If you want to view Near Real Time reports on the central server, rate data must be available 
on the central server. Follow these steps to pull rate data from satellite servers:

1 Add more trendcopy commands by replicating the existing trendcopy commands.

2 Make the following modifications to replicated trendcopy commands:

• Change SHDevRes_Device to SRDevRes_Device

• Change SHDevRes_DeviceMem to SRDevRes_DeviceMem

• Change SHDevRes_DeviceCard to SRDevRes_DeviceCard 

3 Comment out the hourly trendsums in the DeviceResourceReporting_Hourly.pro 
file.

4 Open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

5 Uncomment the copy commands in the rate_copy block.

6 Modify the copy commands in the rate_copy block as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name.

• Replace THIS_MACHINE_DATABASE with the central server name.

7 If you have multiple satellite servers, create and configure new hourly copy commands for 
each additional machine. 

Copying rate data from satellite servers every hour has two side-
effects: traffic between servers increases, and the load on the 
central server increases.
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Configuring Satellite Servers

Follow these steps to configure a satellite server.

1 Disable daily aggregations:

• Open the $DPIPE_HOME/lib/trendtimer.sched file.

• Comment out lines referencing DeviceResourceReporting_Daily.pro.

2 Change the default that determines when hourly processing begins; make hourly 
processing begin sooner:

• Open the $DPIPE_HOME/lib/trendtimer.sched file. 

• Locate the trendtimer entry in the DeviceResourceReporting_Hourly.pro file. 
By default, hourly processing begins at 40 minutes after the hour. 

• To make sure the satellite server completes hourly summarizations before the central 
server begins to copy data from the satellite server, change the start time from 
1:00+40 to 1:00+25.

3 Configure datapipe polling policies; make sure that each network device is polled by one 
satellite server only.

4 If the satellite server has two or more pollers, create separate polling policies for each 
poller and use views and types to separate the devices.

5 If remote pollers are being used, be sure to avoid duplicate polling across the pollers and 
duplicate polling between the satellite and the pollers.

System Clocks

Verify that the system clock on each satellite server is synchronized with the system clock on 
the central server.

These steps are not necessary if:

• The satellite server is performing local reporting.
• The satellite server is not running the thresholds sub-package.
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Chapter 4
Exception Thresholds

This chapter covers the following topics: 

• Default thresholds for exceptions

• Using the change form to modify thresholds

Default Thresholds for Exceptions

The Device_Resource_Thresholds sub-package imposes an exception threshold on CPU 
utilization, memory utilization, and buffer utilization. When performance reaches one of these 
defaults, the thresholds sub-package sends a trap to the network management system. If your 
OVPI and NNM servers are integrated, the thresholds sub-package sends the trap to NNM. 
The trap becomes an alarm in the NNM alarm browser.

The following table describes the condition behind each threshold breach and the severity of 
the alarm sent in response to the breach.

You do not have to do anything to enable these thresholds. However, if you want to enable 
multiple types of traps, or set up multiple trap destinations, you must configure the 
Thresholds Module. For details, refer to the Thresholds Module 5.0 User Guide. 

Using the Change Form

Device Resources 3.0 provides a change form for modifying default thresholds. Follow these 
steps to access the Update Thresholds form:

1 Click the Objects icon in the panel on the left side of the Management Console window. 
The Object/Property Management view opens. 

Metric Threshold Severity

CPU 85% Medium

Memory 85% Medium

Buffer 85% Medium
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Using the Change Form
Object Manager shows a list of objects. The type of object presented depends on which 
Object Manager View is open:

• The Device view (the default) shows a list of devices

• The Customer view shows a list of customers

• The Location view shows a list of locations

2 To change the view, select View > Change View and use the pop-up window to select a 
different view. 

3 When you see the type of object you are interested in updating, select the particular object 
you would like to update. Object Specific Tasks appears in the window on the right. 

4 Double-click the task to open the Update Thresholds form, shown below.
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Chapter 5
Top 10 Reports

Device Resources contains three Top Ten reports:

• Customer Top Ten

• Device Top Ten

• Location Top Ten

Use these reports to identify which customers, locations, and devices rank worst in terms of 
CPU, memory, and buffer utilization. The customer report aggregates statistics for groups of 
devices belonging to one customer, while the location report aggregates statistics for groups of 
devices at various locations belonging to one customer. The device report does not aggregate 
data. It displays statistics for the individual devices belonging to one customer. 

In addition to ranking customers, locations, or devices, each Top Ten report also sorts items by 
highest F90 value, the utilization level that OVPI predicts will be in effect 90 days from today. 
Note that left and right tables are independent and that an item appearing in the worst 
performing table on the left may not appear in the forecast table on the right. If the same item 
appears in both tables, you can assume that yesterday’s performance is part of a longer-term 
trend that may call for corrective action.

The tables on the left provide statistics for yesterday’s average utilization and yesterday’s 
busy hour. Table entries sort according to average utilization, highest to lowest. The tables on 
the right provide statistics for baseline, F30, F60, and F90; table entries sort by F90 value, 
highest to lowest. Baseline here means average busy hour.

The Device Top Ten begins with a customer summary table that sorts customers by resource 
utilization, highest to lowest. The Customer Top Ten and the Location Top Ten begin with a 
customer exception count table that sorts customers by yesterday’s total exception count, 
highest to lowest.

See below for samples of all three Top Ten reports.
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Chapter 6
Summary Reports

Summary reports focus on groups of devices rather than individual devices. If a graph 
monitors utilization for all the devices belonging to one customer, or all the devices in one 
location, you are looking at a summary report. If a graph provides hourly and daily data, and 
the samples that constitute the hourly value and the daily value are based on averages, again 
you are looking at a summary report. 

The customer summary report focuses initially on the threshold exception count for specific 
customers. Customers sort by the number of exceptions, highest to lowest. The graphs below 
track CPU, memory, and buffer utilization. A bar chart displays the exception count hour-by-
hour and day-by-day, while the Grade of Service chart provides an overall score for the 
customer, hour-by-hour and day-by-day. Use the Customer Summary to look at resource 
utilization customer by customer. 

The location summary is exactly the same as the customer summary, except for the location 
selection table providing an exception count for all the locations belonging to one customer. 
The graphs look at resource utilization for all the devices in one specific location. A bar chart 
displays the exception count hour-by-hour and day-by-day for this location, while the Grade of 
Service chart provides an overall score for this location on an hourly and daily basis.

The historical summary reports focus initially on busy hour and then provide detailed 
analysis, in the form of hourly and daily aggregations, for individual devices or individual 
cards on one device. The first table sorts customers by aggregated busy hour, highest to 
lowest, allowing you to easily compare one customer to another. Select a customer to populate 
a table of devices belonging to that customer, sorted by resource utilization, highest to lowest. 
Select a device to populate a frequency distribution pie chart and graphs that track average 
and maximum utilization for CPU, memory, and buffer. Here, maximum utilization is a single 
sample, specifically, the highest sample for the hour or for the day, not an average of multiple 
samples. 

Like the historical summaries, the exception summary is device-specific. This report 
focuses initially on exception counts per customer. Select a customer to populate a table 
showing which devices were responsible for those exception counts. Use the hourly graphs to 
find out exactly when those exceptions took place. Compare the hourly graph to the daily 
graph to find out whether yesterday’s exception count is an isolated incident or part of a 
longer-term trend.

See below for samples of all six summary reports, including the backplane historical 
summary.
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Chapter 7
Forecast Reports

The three forecast reports in Device Resources focus on Days to Threshold (DTT) and provide 
estimates for future utilization. The threshold is 90% utilization, and the value for DTT 
indicates how close the device is to reaching 90% utilization. 

The customer and location reports are actually summary reports, aggregating data by 
customer or by location. The DTT values in these reports are actually averages across all 
devices for that customer, or all devices in that location. For example, if the memory 
utilization DTT is 17 for a customer, many devices could be closer to that threshold while 
many devices could be further away from it.

If you want to see which customer is closest to a threshold, or which location is closest to a 
threshold, start with the summary reports. If a customer or device looks suspicious, use the 
device report to pinpoint the devices that appear to be causing the problem. The device report 
provides DTT and forecasts for specific devices; the data is not aggregated.

All three reports use the same criterion for inclusion: a customer, location, or device appears 
in the report if CPU, buffer, or memory utilization is expected to exceed the exception 
threshold sometime within the next 90 days. The three graphs under the DTT data allow you 
to find out which resource is contributing to the problem. Each graph has three tabs:

• Standard

• Day of Week

• History

Use the standard graph to compare the baseline (average busy hour during the baseline 
period) to F30, F60, and F90. Use the day of week graph to compare the baseline to F30, F60, 
and F90 on a day of week basis and to find out whether resource usage is correlating with a 
particular day of the week. Use the history graph to compare average utilization to busy hour 
utilization over the baseline period. In the hourly graph, average utilization is based on four 
samples. In the daily graph average utilization is based on 96 samples (4 samples per hour, 24 
hours per day).

The F30, F60, and F90 values are produced by applying linear regression to busy hour values 
recorded over the baseline period. Busy hour is the highest average utilization for the day.   
During that hour, actual utilization may have been considerably higher for at least a portion 
of the hour. Busy hour reflects a persistent event, not a momentary spike. When busy hour is 
high, you want average utilization to be low. If average utilization is high, you know that 
resource utilization has been high for an extended period of time.
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Chapter 8
Service Level Management

The Service Level Management report focuses on the availability of individual devices and 
network response time. Use this report to see if availability and network response time are 
meeting levels guaranteed by service level agreements.

An available device is a device that returns a request from the polling agent. The calculation 
that determines availability has limitations. Although it can compensate for network issues 
that may prevent the device from responding to a polling request, it cannot tell the difference 
between a device that is down and a device that is busy and not able to respond. Given this 
limitation, you may want to use the availability statistics in this report as one indicator of 
device availability, not your only indicator of device availability.

Network response time is defined as the length of time that elapses from the moment a 
request is sent by the datapipe to the moment the answer is received by the datapipe. This 
perspective on response time is different from the user’s perspective. Since the perspectives 
are different, you should interpret response time increases as an indicator that traffic may be 
congested and that the delay experienced by users may be comparable.

Selecting a customer from the customer list populates two tables:

• Devices sorted by availability

• Devices sorted by network response time

The first table sorts devices by availability, highest to lowest. The second table sorts devices 
by busy hour, highest to lowest. 

Selecting a device populates two graphs:

• Device availability, hourly and daily

• Average network response time vs. busy hour network response time

The hourly view of device availability covers a 24-hour period, midnight to midnight. The 
daily view begins with yesterday and covers the previous two weeks. If you see low 
availability, or high response time, compare yesterday’s performance with performance over 
the past two weeks to see whether yesterday’s performance is consistent with recent history 
or different from recent history.
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Chapter 9
Near Real Time Reports

The two Near Real Reports in Device Resources—the QuickView and the Snapshot version of 
the QuickView—focus on resource utilization over the last six hours and the last 24 hours. 
The selection table at the top of the report sorts devices by resource utilization, highest to 
lowest. It displays average utilization for CPU, memory, and buffer, using for input all the 
samples taken during the last six hours, which, in practice, means approximately 24 samples. 
If samples are taken every 15 minutes, then the most recent sample in this average is only 
several minutes old. 

While the table at the top of the report provides averages for the previous six hours, the CPU, 
memory, and buffer graphs monitor activity over the previous 24 hours. You also have a grade 
of service chart that ranks service quality over the last six hours. Since the Near Real Time 
report is recalculated after every poll, you can use this chart to find out whether a situation 
you are watching closely is improving or getting worse.

Because the table at the top highlights devices with the worst utilization, you can use the 
NRT QuickView to identify which devices, if any, are having trouble. In addition, if an average 
in the table seems abnormal, you can compare the average in the table to the previous 24 
hours to see if the current average reflects an existing condition or something completely new. 
If a summary report for yesterday points to a situation that could become problematic, the 
Near Real Time report will tell you whether that condition is improving, worsening, or staying 
about the same. The benefit of course is that the advance warning you get from this report 
will let you correct the problem before it becomes a serious issue for users. 

Due to space limitations, the time period in the three rate data graphs may be partially 
concealed. You can easily improve your view of the data by right-clicking the graph, selecting 
View in New Frame, and resizing the window. Once resized, every hour will be clearly 
visible. 

The Snapshot version of the Near Real Time QuickView operates just like the Snapshot 
version of the Historical Summary. Launch the report, then respond to the prompts that ask 
you which device or devices you want included. If a summary, top ten, or forecast report has 
already alerted you to a device with resource problems, and this device is not appearing in the 
NRT QuickView, you can launch the Snapshot version to see where utilization levels are right 
now and what has happened since yesterday.

See below for samples of these reports: 

• QuickView NRT

• QuickView NRT Snapshot

• Backplane NRT
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Chapter 10
Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to display a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click  (the Edit icon) next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables
Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 
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View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.
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View Options for Graphs
Style Options

Select Style to display a list of seven view options for graphs.

Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.

Option Function
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To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.
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View Options for Graphs
Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 

Display Data Table

This option changes a graph into a spreadsheet. 
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View Options for Graphs
View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Availability

The percentage of time the device is operational. This measurement accounts for outages indicated by the 
sysUpTime variable; however, it does not account for periods of time the device could not be reached by 
OVPI.

Average utilization

In an hourly graph, this value is an average of four samples taken over a one-hour period. In a daily graph, 
this value is an average of 96 samples taken over a 24-hour period.

Baseline

The average busy hour over the baseline period. Rate of growth, a statistic that appears in forecast reports, is 
calculated by dividing F30 by the average busy hour.

Baseline period

The previous 91 days. Forecasts for F30, F60, and F90 are based on performance during the baseline period.

Buffer utilization exception

Recorded when buffer utilization exceeds the allowable threshold.

Buffer utilization threshold

When buffer utilization is above this value, an exception is generated. The default value for the threshold is 
85%.

Busy Hour

The definition varies depending on what is being measured. Busy hour is either a busy hour total, or a busy 
hour average. A busy hour total points to the hour of the day that recorded the highest number of events, for 
example, the highest number of discards or the highest number of errors. In Device Resources, busy hour is 
the highest hourly average for the day. Busy hour is a relatively persistent event. Do not confuse busy hour 
with peak, a momentary event. Since busy hour is an average, you may assume that actual utilization could 
have been significantly higher or lower during the course of that hour. Busy hour average refers to the 
highest average hour among 24 hourly averages; this term is synonymous with busy hour. Average busy 
hour refers to an average of all busy hour values over the baseline period and is synonymous with baseline.

Card

Whether or not performance information at the card level is available depends on the make and model of the 
device. Some vendors maintain a distinction between CPU and card, and some do not. Vendors who do 
maintain the distinction may not maintain it uniformly across all equipment. The card selection table in the 
card historical summary report may contain just one entry or it may contain multiple entries. If you see just 
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one entry, it is possible that the device contains just one card, or it could indicate that the device is not able to 
report multiple cards. If the device cannot report multiple cards, the statistics that display at the card level 
are exactly the same as the statistics that display at the device level.

Common Property Tables

Customer names can appear in reports if you import customer names using the Common Property Tables 
package. As explained in the Common Property Tables User Guide, two methods of property import are 
available, a batch-oriented property import utility, and a series of forms for creating and updating customers, 
locations, and nodes. If you do not import customer names, data from every customer will roll up under All 
Customers. If you do not import locations, data for all locations will roll up under All Locations.

CPE utilization exception

Recorded when CPU utilization exceeds the allowable threshold.

CPU utilization threshold

When CPU utilization exceeds this value, an exception is generated. The default value for the threshold is 
85%. 

Daily

A view of performance that compares average utilization to busy hour utilization. The number of days that 
you can see in this view depends on the number of days that data has been collected. The maximum number 
of days is the rolling baseline, 91 days. Note that daily views also include performance data from yesterday, 
the same data currently visible in the hourly view, rolled up as one average and one busy hour.

Days to Threshold (DTT)

The number of days that will elapse before utilization is expected to reach 90%. Device Resources calculates 
DTT for CPU utilization, memory utilization, and buffer utilization.

Device

A router or a switch, not a server. In selection tables, devices are listed by IP address or hostname. 

Grade of Service

A total score based on a combination of contributing scores, sometimes equally weighted, sometimes not. In 
Device Resources the GOS is equally-weighted and it combines scores for memory, buffer, and CPU as 
follows: 

GOS =  GOS memory +  GOS buffer +  GOS CPU

Hourly

An average derived from four collections taken once every 15 minutes; also a graph showing yesterday’s 
hourly increases and decreases. 

Memory utilization exception

Recorded when memory utilization exceeds the allowable threshold.

Memory utilization threshold

When memory utilization exceeds this value, an exception is generated. The default value is 85%.

1
3
--- 1

3
--- 1

3
---
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Near Real Time

An average for performance over the previous six hours, ending with the most recent poll. If polling takes 
place 4 times per hour, the NRT average is derived from 24 samples. The NRT average is a rolling average 
and is recalculated at the conclusion of each poll. 

Network response time

The time that elapses from the moment the poller sends an SNMP request to a device to the moment the 
poller receives a response from the device. 

Summary

An aggregation of multiple samples. In an hourly graph, an average based on multiple samples collected 
during one hour; in a daily graph, an average based on multiple samples collected over the course of each 
day. In customer and location reports, an aggregation of multiple averages for multiple devices across the 
same hour, the same day, or the same month.

Utilization

Utilization for a time period, measured as a percentage; the value of the metric in use divided by the total 
available resources for that metric, multiplied by 100.
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